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Microsoft Office 2003 Introduction

Welcome to Microsoft® Office PowerPoint® 2003, part of Microsoft Office 2003 Editions—the easiest way to help more people use information to make a positive impact on business. The Office 2003 Editions offer new technologies and features while improving upon existing and familiar tools to facilitate effective and efficient collaboration and information sharing.

This document provides an overview of the Office 2003 Editions and how they can help you connect people as well as gain access to valuable online Help services. We will take a close look at PowerPoint 2003 in action, offering guidance on the specific details of this integral part of Office 2003 Editions.

Through integration with Microsoft Windows® SharePoint™ Services, the Office 2003 Editions offer advances in intranet collaboration to help users gain access to and share information both internally and externally. Support for Information Rights Management (IRM) and industry-standard Extensible Markup Language (XML) provides a platform on which to build cost-effective solutions that can have an immediate, positive impact. In addition, the Office 2003 Editions offer new ways to organize and manage e-mail and make more use out of the workday.

Design Goals

With a focus on connecting people, information, and business processes, the design goals integrate collaboration, usability, and information management.

Connect people

Designed to integrate with intranet technologies such as Windows SharePoint Services (WSS), the Office 2003 Editions provide new ways to connect individuals, teams, and organizations. By incorporating the new tools with familiar Microsoft Office menus, functions, and interfaces, training and implementation time is minimized. Workers can collaborate from any location by using shared information and simplified review processes, including the following features:

· New! Shared Workspace task pane facilitates and simplifies efficient collaboration and document sharing.

· New! Shared Attachment option offers an automatic way of creating Document Workspaces through e-mail messages when sending attachments for review. Document Workspaces provide a forum for managing collaborative review on projects, with features such as automatic updates to the most current version, and the ability to share documents and other relevant information in real time.

· New! Meeting Workspace option automatically creates workspaces through Microsoft Office Outlook® invitations. Meeting Workspaces help enhance the productivity of meetings by providing a place to coordinate schedules, disseminate materials, and store notes and minutes.

· New! Instant Messaging (IM) and Alerts technology is integrated throughout the Office 2003 Editions collaboration tools, providing instant information and the ability to initiate IM conversations quickly from within documents, Shared Workspaces, or Outlook 2003. 

· New! Information Rights Management (IRM) functionality protects sensitive information from unauthorized distribution or alteration, and allows companies to set and enforce policies that help control how their data is used.

Connect information

The Office 2003 Editions are designed to make it easier for people to manage an ever-increasing volume of business information. Improvements and new features in Outlook 2003 enable users to organize and prioritize e-mail messages quickly and easily, and new security settings offer increased support for junk e-mail filtering. Support for remote and mobile workers includes improvements to connectivity performance, such as better caching, and shared calendars. Obtaining information from a variety of locations is made easier with organizational tools, such as the Research task pane. The following are new and improved features for connecting information:

· Improved! Enhanced Rules and Alerts provide automated organization of incoming e-mail messages, in addition to automatic notifications so that users can stay current with incoming e-mail messages without spending extra time doing so. Alerts can also be integrated with Document Workspaces to notify users about important project developments.

· Improved! Research task pane accesses needed information more efficiently. 
· Improved! Enhanced Ink support provides a better experience overall when using Tablet PCs, offering support for handwritten e-mail messages and the ability to write directly in Word 2003, Microsoft Office PowerPoint 2003, and Microsoft Office Excel® 2003 documents.
Connect business processes

Often, critical business information is kept separate from the programs that workers know and use. With its extensive support for industry-standard XML, the Office 2003 Editions help bring business processes and information together on the desktop. To facilitate greater efficiency, features such as Smart Documents and Programmable task panes help users share customizable, task-specific information easily. New and improved tools for connecting business processes include the following features:

· New! Customer-defined XML schema support is available in Word 2003 and Excel 2003.

· New! Smart Documents bring relevant information directly to the task at hand through a new Programmable task pane user interface. With Smart Documents XML solutions can be created to enable business processes, help users complete forms and other documents, and then link that information to back-end systems that support XML. As the user clicks through the document, the program is modified to present the appropriate functions to complete the task.

· New! Extensible Smart Tag support is now offered in all the Office programs including PowerPoint 2003, Outlook 2003, and Microsoft Office Access 2003. Support includes automatic configuration capabilities such as formatting and populating an index at the end of an article.

System Recommendations

To use the Office 2003 Editions, here are the system requirements:

· Personal computer with an Intel Pentium 233-megahertz (MHz) or faster processor (Pentium III recommended)

· Microsoft Windows 2000 with Service Pack 3 (SP3) or later; or Windows XP or later

· Super VGA (800 × 600) or a higher-resolution monitor

· 128 megabytes (MB) of RAM or more 

Hard disk usage will vary depending on configuration; custom installation choices may require more or less hard disk space. The following are the hard disk requirements for individual Office 2003 Editions.

Microsoft Office Professional Edition 2003 

· 400 MB of available hard disk space; 190 MB of hard disk space for Outlook 2003 with Business Contact Manager 

· Optional installation files cache (recommended) requires an additional 290 MB of available hard disk space.

Microsoft Office Small Business Edition 2003 

· 380 MB of available hard disk space; 190 MB of additional hard disk space to use the optional installation of Outlook 2003 with Business Contact Manager 

· Optional installation files cache (recommended) requires an additional 280 MB of available hard disk space

Microsoft Office Standard Edition 2003 

· 260 MB of available hard disk space 

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space.

Microsoft Office Student and Teacher Edition 2003 

· 260 MB of available hard disk space 

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space.

Additional items or services

Some features or advanced functionality have additional requirements.

Microsoft Office Professional Edition 2003

To use the optional installation of Outlook 2003 with Business Contact Manager, you need to meet the following system requirements:

· A PC with a Pentium 450-MHz or faster processor 

· 260 MB of RAM or more recommended 

· 190 MB of additional hard disk space 

· For speech recognition: 

· Pentium II 400-MHz or faster processor

· Close-talk microphone and audio-output device

· Microsoft Exchange Server is required for certain advanced functionality in Outlook 2003.

Microsoft Windows Server™ 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality.

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply.

Certain inking features require running Microsoft Office on the Microsoft Windows XP Tablet PC Edition.

· Information Rights Management features require access to a Microsoft Windows 2003 Sever running Windows Rights Management Services.

Note: Business Contact Manager will be disabled in the presence of an Exchange-technologies-based e-mail system.

Microsoft Office Small Business Edition 2003

· To use the optional installation of Outlook 2003 with Business Contact Manager you need to meet the following system requirements: 

· A PC with a Pentium 450-MHz or faster processor

· 260 MB of RAM or more recommended

· 190 MB of additional hard disk space

· For speech recognition: 

· Pentium II 400-MHz or higher processor

· Close-talk microphone and audio output device

· Exchange is required for certain advanced functionality in Outlook 2003.

Note: Business Contact Manager will be disabled in the presence of an Exchange-technologies-based e-mail system. 

· Windows Server 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality.

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply.

Office Standard Edition 2003

· For speech recognition: 

· Pentium II 400-MHz or faster processor

· Close-talk microphone and audio-output device

· Microsoft Exchange Server is required for certain advanced functionality in Outlook 2003

· Microsoft Windows Server 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality.

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply.

· Certain inking features require running Microsoft Office on the Microsoft Windows XP Tablet PC Edition.

This section examines the design goals, system recommendations, and additional services of Office 2003 Editions. The next two sections take a deeper look at Office 2003 Editions and how they facilitate connecting people, focusing on PowerPoint 2003.

Introduction 

Every employee faces challenges when a project requires team collaboration. The Microsoft Office 2003 Editions and the integration with Microsoft Windows SharePoint Services (WSS) provide a platform that includes programs employees use daily to work with team members in a centralized location, making the team’s work more effective and efficient.

The Office 2003 Editions allow for closer teamwork experience. New task panes from within the documents and e-mail messages provide information about other team members and also offer access to resources. Team members can use Instant Messenger (IM) integration to see when other team members are online or offline. New calendar features in Microsoft Outlook 2003 make scheduling meetings with other team members quicker and more effective. The Office 2003 Editions also offer content protection rights to authors, ensuring that authors have complete access to and control over their documents.

Windows SharePoint Services Integration with Office 2003 Editions Programs

The integration of Office 2003 Editions programs and WSS offers users tools that are powerful and easy to use and that make collaboration easier. A WSS site provides a virtual community for team collaboration—making it easy for users to work together on documents, projects, events, and other activities where information sharing is essential.

In addition to the new Workspaces, Outlook 2003 offers a workgroup server, offline availability, and multiple calendar views and lists. Microsoft Office Access 2003 has features that allow users to link tables to other SharePoint Web sites and preserve full read/write capabilities. Because Microsoft Office Excel 2003 and the various SharePoint lists are integrated more closely, a user can import or export a list to or from Excel and share it with other team members. The Office 2003 Editions program and WSS integration gives users more opportunities for increased accessibility to view, edit, read, or write information within Outlook, Access, and Excel.

Linked tables between PowerPoint 2003 and Windows SharePoint Services 

Users can now link tables that were created in PowerPoint 2003 to lists on SharePoint Web sites and maintain full read/write capabilities. Users specify that they want to use SharePoint as the type, and then they select the Web site and the list name.

This means that WSS can act as a new type of database server for PowerPoint 2003 users who want to collaborate with others across the Web and use the familiar desktop program interface, or who want to incorporate SharePoint data into other tracking projects that they already perform. 

The following table shows WSS integration features for each program in Office 2003 Editions:

	Windows SharePoint Site Feature
	

	Open and Save from File menu
	Excel, Outlook, PowerPoint, Publisher, Word

	Shared Workspace task pane
	Excel, PowerPoint, Word

	Document updates for shared attachments
	Excel, PowerPoint, Word

	Automatically collect metadata
	Word, Excel, PowerPoint

	Check-in / check-out
	Word, Excel, PowerPoint

	Version Tracking
	Word, Excel, PowerPoint

	Store inline discussions on the server
	Word, Excel, PowerPoint


Help Protect Sensitive Documents

New technologies in Office 2003 Editions help protect digital intellectual property. Information Rights Management (IRM) in Office 2003 Professional allows functions such as cut, copy, paste, print, and e-mail forwarding to be restricted for specific documents and e-mail messages, giving users and organizations more control over their valuable information assets. With Word 2003, in-document editing rights and style protection allow document owners to specify who is allowed to make changes.

Information Rights Management in Office 2003 Editions

IRM is a new policy enforcement technology in Office 2003 Editions that helps protect documents and e-mail messages from unauthorized access and use. IRM is a persistent, file-level protection technology that allows the owner to specify who can access a document or e-mail and control whether those users are allowed to edit, copy, forward, or print the contents. IRM is an extension of Windows Rights Management Services™ (RMS) into Office 2003 programs. IRM in Office Professional 2003 requires RMS on Windows Server 2003, either within the organization or via a service such as Microsoft Passport. Windows Rights Management Services for Windows Server 2003 is a new premium service that requires a separate Client Access License (CAL).

IRM is a policy enforcement technology, not a security technology, allowing documents and e-mail messages to be distributed while helping maintain control over who can access content and how they can use it. Once a document or e-mail is protected with this technology, the access and usage restrictions are enforced no matter where the file or e-mail goes. 

IRM support in Microsoft Office 2003 Editions helps corporations and knowledge workers address two fundamental needs. It: 

· Helps protect digital intellectual property. Most corporations today rely on firewalls, login security, and other network technologies to protect their digital intellectual property. The fundamental limitation of these technologies is that, after legitimate users have access to the information, the information can be intentionally or accidentally shared with unauthorized people, creating a potential breach in security policies. IRM helps protect the information itself from unauthorized access and reuse.

· Helps ensure information privacy, control, and integrity. Knowledge-capital workers often deal with confidential or sensitive information, relying on the 

discretion of others to keep sensitive materials in-house. IRM helps eliminate the risk of accidental leaks by disabling the forward, paste, or print functions in IRM-protected documents and e-mail messages. In addition, IRM can enforce expiration dates to help ensure that knowledge-capital workers see and use up-to-date content only.

For information technology (IT) managers, IRM helps enforce enterprise policies regarding document confidentiality, workflow, and e-mail retention. For CEOs and security officers, it helps reduce the risk of having key company information get into the hands of the wrong people, whether by accident, thoughtlessness, or malicious intent. 

When enabled by the organization, users of Office 2003 Editions will be able to easily take advantage of this technology. To create and protect documents and e-mail messages with IRM, Office Professional Edition or the full stand-alone products are required. A simple user interface based on customizable “rights templates” available in the standard toolbar makes IRM convenient and easy to use. Other Office 2003 Editions will give users the ability to read and edit IRM-protected content, but not create. Integration with Active Directory® provides a level of convenience not seen on today’s document-specific passwords. 

Finally, IRM-protected documents and e-mail can be shared across organizations and with users who do not have Office 2003 Editions. Microsoft is offering, for a limited time, an IRM service for customers who do not host their own Windows Rights Management Services Server. The Rights Management Add-On for Microsoft Internet Explorer allows Windows users to consume IRM-protected documents whether or not they have Office 2003 Editions. This service will use Microsoft Passport, instead of Active Directory, as the authentication mechanism. Users of this service will not be able to create custom rights templates, such as a company’s confidential template, but they will be able to share and access IRM-protected documents and e-mail messages.

Leveraging Information Rights Management (IRM) in PowerPoint 2003 

IRM in Office Professional Edition 2003 allows the document owner to assign permissions to individual users and groups (groups based on Active Directory). In PowerPoint 2003, each user or group can be given a set of permissions according to the following roles: read, change, and full control. Depending on the recipient’s role, IRM disables certain commands to enforce the rights that are assigned. The document owner can also prevent printing and can set expiration dates. After expiration, documents cannot be opened.
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Users can apply usage restrictions to limit who can read, change, or control Excel 2003, Word 2003, and PowerPoint 2003 files.

Permission options 

If a protected document is forwarded to an unauthorized recipient, the document cannot be opened and an error message that contains the document owner’s e-mail appears so that the recipient can request additional rights. If the document owner decides not to include an e-mail address, unauthorized recipients get an error message. 

Organizational policies and template options

On the Windows Rights Management Services server, organizations can create “rights templates” that will appear in Office Professional Edition 2003. For example, a company might define a template called Company Confidential, which specifies that a document or e-mail in that template can only be opened by users inside the company domain. These templates can reflect the policies of the organization, and the number of templates that can be created is unlimited. 

Rights Management Add-On for Internet Explorer

Because enforcement of rights is done at the application level, Office files protected with IRM technology can only be opened and edited by Office 2003 Editions. However, 

Rights Management Add-On for Internet Explorer allows users without Office 2003 Editions to read IRM-protected materials. The Rights Management Add-On for Internet Explorer is available for download free of charge at www.microsoft.com (connect-time charges may apply).

The Rights Management Add-On for Windows Explorer will play an important role in communication between business units and with business partners, as companies may choose to migrate to Office 2003 Editions on their own timeframes. Companies can use IRM in Office 2003 Editions knowing that authorized users will be able to access and consume protected content, even if they do not have Office 2003 Editions.

Additional server requirements

Microsoft Windows Server 2003 with Rights Management Services and Active Directory are required to enable IRM fully in Office Professional Edition 2003. The Rights Management Services feature requires a premium Client Access License (CAL). Microsoft is also hosting, for a limited time, an IRM service through Passport for customers who do not have the Windows Server 2003. This service will enable users to share protected documents and e-mail by using Microsoft Passport as the authentication mechanism.

Note that users of Office Standard Edition 2003, Office Small Business Edition 2003, and Office Student and Teacher Edition 2003 cannot create new IRM-protected documents or e-mail messages, or modify the permissions on existing IRM-protected files. However, they can open, edit, save, and print IRM-protected documents and e-mail messages with the appropriate permissions.

Regional permissions

When teams collaborate on very large documents, some users may be assigned certain portions of the document to work on at any given time. In the past there was no way to ensure that each user only modified the assigned portion of the document. When it came time to reconcile the edits and merge changes into a master document, large numbers of conflicting edits often caused problems.

Document owners can set permissions to certain regions or specific portions of a document from being editing by some or all users. Using the Protect Document task pane (by selecting the Tools menu, and then Protect Document), a document owner can first protect the whole document against any edits (optionally allowing only comments), and then assign permissions to individual portions of the document by selecting them and specifying the users who should be able to edit that selected region. Later, when reconciling the changes of different individuals, the document owner is assured that no two people edited the same area, and no conflicts exist.
After the permissions have been set up, the task pane switches focus from helping the creator set up the permissions and managing the list of users to helping users find the parts of a document that they can edit. 
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User view of the Protect Document task pane. 

Summary

The Office 2003 Editions and WSS integration make it easier and more efficient for users to connect with other team members and the information that they need. By enhancing the desktop programs that employees are already familiar with, the Office 2003 Editions help users spend their time making progress on their projects instead of learning a new set of features and commands. Office Professional 2003 Edition also allows authors to create documents and e-mail messages that are better protected from unauthorized use by offering IRM technology. This improved functionality in the Office 2003 Editions assists users when working on projects that require team efforts.

Introduction

With information in hand about how Microsoft Office 2003 Editions help users connect with others, it is important to look at the new features Microsoft Office PowerPoint 2003 delivers to its users. These features are individually described within the following sections.

Smart Tag integration

Users can save time by using Smart Tags to perform actions in PowerPoint 2003 that previously required other programs. Smart Tags recognize certain types of text and then offer related functions and commands. With PowerPoint 2003, users can embed Smart Tags so that they are available to anyone who opens the presentation. 

Users might find additional Smart Tags created by Microsoft, by third-party companies, or by information technology (IT) professionals who design Smart Tags and actions for specific products or services that are relevant to their activities.
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Select the types of Smart Tags to recognize and specify their appearance.

How to use Smart Tags

To turn on Smart Tags: 

1. On the Tools menu, click AutoCorrect Options. 

2. Click the Smart Tags tab, and then select the Label text with smart tags check box.
To select a Smart Tag action: 

3. Move the insertion point over text that is underlined with a purple dotted line until Smart Tag Actions [image: image4.png]


 appears. 

4. Click the arrow. The actions that can be performed appear in a list. 

5. Select an action.

To find more Smart Tags, complete the following steps: 

6. On the Tools menu, click AutoCorrect Options. 

7. Click the Smart Tags tab.

8. Click More Smart Tags to go to Web sites to find new Smart Tags and actions.

Thesaurus integration

PowerPoint 2003 now includes a thesaurus that is integrated into the Research task pane. When the integrated thesaurus is opened, a list of suggested synonyms appears. If users select a word from the list, that word replaces the selected term in the text. If the list does not contain an appropriate synonym, users can select Thesaurus from the list to open the full thesaurus and continue the search.
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Use the integrated thesaurus to find just the right word.

How to open the integrated thesaurus

Right-click on a word, select Synonyms, and then select Thesaurus.
-or-
Click Tools, and then click Thesaurus.
-or-
Hold down ALT, and then click on a word.

Ink support

For users working with a Tablet PC, Ink support is available with the tablet pen. Users can add Ink while delivering a presentation or while editing slides. If users are creating or editing slides, they can add Ink drawing and writing to emphasize certain portions of a slide, or use handwriting or hand-drawn pictures to design the overall layout of the information. Ink can be inserted in the following PowerPoint views:

· Normal 

· Notes Page 

· Slide Master 

· Handout Master 

· Notes Master 

· Slide Show 
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Add Ink to PowerPoint slides.

How to use Ink to edit slides

On the Insert menu, click Ink Drawing and Writing. 

Annotations in Slide Show view

PowerPoint 2003 has improved annotation support. Tablet PC users can mark slides with Ink while in Slide Show view. Users can make comments or answer questions that are asked during the presentation by adding them directly to the slides. Users can also take notes on slides and save the ink on the slides for later use. 

PowerPoint 2003 has updated the Pen Tools in Slide Show with more colors and types of pens to choose from, in addition to giving users the ability to highlight parts of the presentation by using a new highlighter tool. 
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Make comments directly in a slide using Ink.

How to make annotations while in Slide Show view

9. Place the tablet pen or mouse over the pen icon on the lower right of the slide.

10. Click the arrow on the slide show toolbar, and then click Ballpoint Pen, Felt Tip Pen, or Highlighter. 

11. To cancel the selection of Ink, click away from the selected Ink.
Expanded playlist formats

PowerPoint 2003 now supports the following audio playlist formats: ASX, WMX, M3U, WVX, WAX, and WMA. Also, if a media codec (software that is necessary to play the selected files) is not available, PowerPoint 2003 tries to download it from the Web by using Microsoft Windows Media® player technology. 
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Insert a supported playlist in a presentation.

How to insert a playlist in a slide

12. On the Insert menu, point to Movies and Sounds.

13. Click Sound from File. 

14. Find the folder that contains the playlist to be inserted, and then double-click the playlist.

How to find more sounds, movies, and clip art

15. On the Insert menu, point to Movies and Sounds.

16. Click Sound from Clip Organizer or Movie from Clip Organizer.

17. In the Clip Art task pane, click Clip art on Office Online.

Full-screen playback

Movies that are embedded in a slide can now play across the entire screen during a slide show. To enable this feature, users select the check box in the Movie Options dialog box. Alternatively, users can leave the check box cleared if they want the movie to play in a rectangle within the slide.
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Use the new setting in the Movie Options dialog box for full-screen playback in a slide show.

How to select full-screen playback

Use either of these methods to select full-screen playback: 

18. Right-click on the movie.

19. Select Edit movie object from the context menu.

20. Select the Zoom to full screen check box.

-or-

21. In the Custom Animation task pane, click the Play effect. 

22. On the Gallery menu, select Effect Options.

23. Click the Movie Settings tab, and then select the Zoom to full screen check box.

PowerPoint Viewer and Package for CD

The PowerPoint Viewer displays presentations exactly as the author created them, even on systems that do not have PowerPoint 2003 installed. By using PowerPoint Viewer, users can open protected presentations by using a password and can print presentations. The new PowerPoint Viewer is an improved version of PowerPoint Viewer 97.

PowerPoint Viewer is, by default, part of the Package for CD features. With this feature, users can package presentations onto a CD and distribute PowerPoint presentations 

without worrying if the recipients have the correct version of PowerPoint for viewing. Users can also choose to have the CD play presentations automatically when the CD is inserted in a computer.
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When a presentation is packaged on a CD, even computers that do not have PowerPoint installed can view it.

How to package a presentation for CD

On the File menu, click Package for CD.
As this section demonstrates, PowerPoint 2003 is rich in features and easy to use. Users who require assistance with PowerPoint 2003 can get online help and services for Office 2003 Editions, as described in the next section.

Online Help and Training

Microsoft Office 2003 Editions offer new and improved integration with Microsoft Office Online Web services. More powerful, better integrated, and with an improved online interface, these services are seamlessly available from within Office 2003 programs. The Web site, also available through a browser at www.microsoft.com/office, offers a resource page for each Office 2003 Editions program. The resources pages have assistance, columns, training, and templates.

Help

The Help system of Microsoft Office 2003 Editions has been extended beyond individual workstations. If a user is connected to the Internet when choosing a Help topic or entering a word in the Ask-A-Question box, the Help system displays not only the Help information from the local system but also brings to the Help window information from the Microsoft Web site (www.microsoft.com). This provides the most current information on the topic that the user needs help with, in addition to links to other resources.

Assistance

The Assistance Web page provides up-to-date information with How To articles, conceptual topics, columns, and helpful tips for common tasks. Users can find answers to common questions, read articles on features in Office 2003 Editions, look for specific help in newsgroups, or suggest a topic for a future article.

Office Online Training

The Training site offers Web-based interactive training courses and self-paced exercises. Users can develop deeper knowledge of tasks and application features, such as creating an outline in Word 2003 or using motion paths in PowerPoint 2003 slides. Courses include practice sessions where users can give things a try in the actual program, and short tests to assess comprehension. Courses cover a variety of topics, and are available for any Office 2003 Editions program.
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Use Office Online to find training opportunities for Office programs.

Downloads

On the Downloads site (formerly known as Office Update), users can check for free updates that improve the stability and security of Office 2003 Editions. On the Downloads home page, users can click the Check for Updates button to start the automatic detection tool, which scans the computer and then returns a list of new downloads that are available and compatible with the user's version of Office. In addition to security and performance updates, viewers, converters, add-ins, stationery, and other useful downloads are also available. The most popular downloads are listed in the Popular Office Downloads section.
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